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1. ORDERING GUIDE
Configure a model number in this format: L20201DCV1, CBL01

….Digital panel meter with
screw terminal connectors.

DC Amperes

Note: Extended versions add
rate of change and linearization of non-linear inputs. Not
available for thermocouple or
RTD inputs.

P385F ............. -331 to 1562°F
P392C............... -202 to 850°C
P392F ............. -331 to 1562°F

A

DCA1 .....................2.0000 mA
DCA2 .....................20.000 mA
Display Color
DCA3 ..................... 200.00 mA
1 .............. DPM with green LED DCA4 ..........................5.000 A
2 ..................DPM with red LED
3 .... Extended DPM, green LED 100 Ohm Platinum RTD’s
4 ....... Extended DPM, red LED P385C............... -202 to 850°C

Power
0 ..........95-240Vac, 95-300 Vdc
1 .............10-48 Vdc, 10-34 Vac
Setpoint Output
0 ...................................... None
1 ............Dual 8A contact relays
2 ............ Dual solid state relays
Analog Output
0 ...................................... None
1 ................. 4-20 mA, 0-10 Vdc

Thermocouples
JC ..................... -210 to 760°C
JF ................... -347 to 1400°F
KC .................. -244 to 1372°C
KF................... -408 to 2501°F
TC..................... -257 to 400°C
TF ..................... -430 to 752°F
EC................... -240 to 1000°C
EF ................... -400 to 1830°F
NC .................. -245 to 1300°C
NF................... -410 to 2370°F
SC..................... -46 to 1768°C
SF ..................... -51 to 3214°F
RC .................... -45 to 1768°C
RF..................... -49 to 3213°F

RMS Volts
RMV1.....................200.00 mV
RMV2....................... 2.0000 V
RMV3....................... 20.000 V
RMV4....................... 200.00 V
RMV5* ....................... 600.0 V
RMV6......................... 300.0 V
RMS Amperes
RMA1.....................2.0000 mA
RMA2.....................20.000 mA
RMA3.....................200.00 mA
RMA4......................... 5.000 A
Load Cells (6-wire ratio)
WM1….…..-99,999 to +99,999
Specify min input signal & displayed reading, and max input
signal & displayed reading.
Full-scale inputs 20 mV to 500
mV. 10 Vdc excitation.

Options
EB......... Extra bright red LED
display.
BL ......... Blank lens, no
button pads.

Digital Interface
0 ...................................... None
1 .................................... RS232
2 .................................... RS485
3 ...........................Parallel BCD
4 ...................... RS485-Modbus

Process Signals
(4-20 mA, 0-10V, etc.)

Specify min signal & reading,
max signal & reading.

CBL01 .. RJ11-to-DB9 RS232
cable. Connects meter to PC com port.

Input Type

Strain Gauge, Potentiometer
(4-wire ratio)

CBL02 .. USB-to-DB9 adapter.
For use with CBL01.

DC Volts
DCV1 .......................200.00 mV
DCV2 ..........................2.0000 V
DCV3 ..........................20.000 V
DCV4 ..........................200.00 V
DCV5*...........................600.0 V
DCV6 ............................300.0 V

P…………4-20 mA = 0-100.00
P1…………….Custom Scaling

SG ........ 0-200 mV = 0-100.00
SG1 ............... Custom Scaling

Specify min signal & reading,
max signal & reading. Fullscale ranges 200 mV to 20V.

* Range not UL approved.
2

Accessories

2. TABLE OF CONTENTS

1.
2.

ORDERING GUIDE...................................................................................................... 2
TABLE OF CONTENTS ............................................................................................... 3

3.

PRODUCT INTRODUCTION ....................................................................................... 4

4.

RECEIVING & UNPACKING........................................................................................ 5

5.

SAFETY CONSIDERATIONS ...................................................................................... 5

6.
7.

CONNECTOR WIRING INFORMATION...................................................................... 6
MECHANICAL ASSEMBLY ......................................................................................... 8

8.
FRONT PANEL SETUP KEYS..................................................................................... 10
9. ENABLING & LOCKING OUT MENU ITEMS.............................................................. 12 10.
READING COORDINATES OF 2 POINTS SCALING METHOD ................................. 13 11.
DC VOLTS, AMPS, PROCESS, STRAIN .................................................................... 14 12.
LOAD CELL & MICROVOLT INPUTS.......................................................................... 19 13.
AC RMS VOLTS & AMPS ........................................................................................... 24 14.
TEMPERATURE: THERMOCOUPLE & RTD .............................................................. 29 15.
DUAL RELAY OUTPUT OPTION ............................................................................... 34 16.
ANALOG OUTPUT OPTION........................................................................................ 36 17.
SERIAL COMMUNICATION OPTIONS ....................................................................... 37 18.
PARALLEL BCD OUTPUT OPTION ............................................................................ 40 19.
EXCITATION OUTPUTS & POWER SUPPLY............................................................. 41 20.
INSTRUMENT SETUP VIA PC .................................................................................... 42 21.
CUSTOM CURVE LINEARIZATION ............................................................................ 45 22.
METER CALIBRATION................................................................................................ 47 23.
SPECIFICATIONS ....................................................................................................... 47 24.
GLOSSARY OF TERMS .............................................................................................. 51 25.
WARRANTY................................................................................................................. 56

3

3. PRODUCT INTRODUCTION

These UL-certified digital panel meters are versatile, cost effective solutions to a wide variety
of monitoring and control applications. Depending on the choice of signal conditioner, they are
easily set up for an accurate display of temperature, pressure, flow, weight, voltage or current,
all in appropriate engineering units and with zero and span adjustment when needed. Setup
can be via front panel pushbuttons or RS232/RS485. Selective security lockout of the front
panel keys protects against accidental changes to meter setup.
High read rates up to 60 per second (50 for 50 Hz operation) are made possible by Concurrent
Slope Conversion (Pat 5,262,780), which integrates the signal over an AC power line cycle for
maximum noise rejection. High read rates provide accurate peak and valley capture, and quick
response for control applications. An adaptive digital filter supplies a time constant for the
encountered signal noise level, yet responds rapidly to changes that exceed a selected
threshold. Self-calibration occurs automatically after every 17th reading.
The standard power supply is a high-efficiency switching unit that operates from AC or DC,
and allows the meters to be powered from worldwide AC without changes. A low-voltage
supply is optional for power from 10-48V batteries or 10-34 Vac. Both supplies provide an
isolated 5, 10 or 24Vdc transducer excitation output .
The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 ULrated plastic and is watertight to NEMA-4 (IP65) when panel mounted. Mounting is from the
front of the panel and requires less than 110 mm behind the panel. Power and signal wiring is
via removable plugs conforming to UL61010C safety standards. All output options are isolated
from meter and power ground to 250 Vac.
Extended meter versions can linearize nonlinear inputs. Up to 240 data points may be
linearized by a computer program that stores setup parameters in nonvolatile memory.
Extended meters can also display rate of change. For example, they can display flow based on
changing tank level.
Alarm or setpoint control is made possible by two optional Form C mechanical relays (8A at
250 Vac) or two Form A solid state relays. The setpoints may be latching or non-latching, and
may be configured to be energized above or below the setpoint or in a fail-safe mode. The
relays can operate from the filtered signal to reduce relay chatter or from the unfiltered signal
for fastest response. Snubber circuits and a programmable relay switching time delay extend
relay contact life.
An isolated analog output of 4-20 mA or 0-10V is available with an optional analog output
board. The output is linearized to the display, and can operate from the filtered or unfiltered
signal input. It can be scaled via front panel pushbuttons or RS232/RS485.
Communications options available with Series 2 include RS232 or RS485 I/O, and parallel
BCD output. Serial communications can utilize a custom ASCII protocol or Modbus protocol
compliant with the Modbus Over Serial Line Specification V1.0 (2002) for 2-wire, half-duplex
connection. This includes RTU or ASCII modes, up to 247 digital addresses, and up to 32
devices per RS485 line without a repeater.
Computer-aided meter programming using special Setup Software is available for use with the
RS232 and RS485 serial interfaces.
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4. RECEIVING & UPACKING
Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

5. SAFETY CONSIDERATIONS

Warning: Use of this equipment in a manner other than specified may impair the protection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.
Caution:
•

•

•

•
•

•

This unit must be powered with AC (mains) from 95-240 Vac ±10% (90-300 Vdc) with the
high voltage power supply option, or 10-34 Vac ±10% (10-48 Vdc) with the low voltage
power supply option. Verify that the proper power option is installed for the power to be
used. This meter has no AC (mains) switch. It will be in operation as soon as power is
connected.
The 95-240 Vac (95-300 Vdc) mains connector (P1 Pins 1-3) is colored Green to
differentiate it from other input and output connectors. The 10-34 Vac (10-48 Vdc) mains
connector is colored Black.
Do not make signal wiring changes or connections when power is applied to the instrument.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.
To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.
Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard. This meter is designed to be mounted in a
metal panel.
Verify the panel cutout dimensions, and mount according to instructions.

Symbols used
Caution (refer to accompanying documents)

Earth (ground) terminal.

Caution, risk of electric shock.

Both direct and alternating current.

Equipment protected throughout by double
insulation or reinforced insulation.
Operating environment:
The meter is Class II (double insulated) equipment designed for use in Pollution degree 2.
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6. CONNECTOR WIRING INFORMATION
CONNECTORS
Connectors for signal and power are U/L
rated screw-clamp terminal blocks that
plug into mating jacks on the printed
circuit board. Communication connectors
are a single RJ11 plug for RS232, dual
RJ11 plugs for RS485, dual RJ45 plugs
for RS485 Modbus, and a 30-pin, mass
termination connector for parallel BCD.

Caution: Hazardous voltages may be present
on pins 4, 5 & 6.
Note: Control inputs 1 & 2 are menu selectable.
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P3 - SERIAL COMMUNICATIONS

7

RS232 INTERFACE
N/C
ISO GND
RX
TX
RTS
N/C

6
5
4
3
2
1

Computer
GND
TX
RX
RTS

RS485 INTERFACE - FULL DUPLEX
ISO GND 6

BRX
ARX

3

GND

5

RS485 INTERFACE - HALF DUPLEX
ISO GND

BTX
ATX

4

ATX
ARX BTX 2
ARX ISO GND 1
GND

ATX / ARX
BTX / BRX
ISO GND

RS485-MODBUS - FULL DUPLEX
ISO GND
TXD0
TXD1
RXD1
RXD0

8
7
6
5
4
3
2
1

6
5
4
3
2
1

GND
ATX / ARX
BTX / BRX
GND

RS485-MODBUS - HALF DUPLEX

GND

ISO GND

RXD0
RXD1

D0
D1

TXD1
TXD0
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8
7
6
5
4
3
2
1

GND
D0
D1

7. MECHANICAL ASSEMBLY
REMOVING THE REAR PANEL
First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.
Retaining tab
with tab release

Retaining tab
with tab release

Retaining tab
Retaining tab

Rear Panel
REMOVING THE ELECTRONICS
With the rear panel removed, grasp the power supply board to the left and signal conditioner board to the right, and carefully slide the electronic assembly out through the rear of
the case. (see figure below).

INSTALLING NEW 0PTION BOARDS
Options boards plug into the main board at the front of the meter. These are plug-and-play
and may installed in the field. They will be recognized by the software, which will provide
access to the menu items associated with that board. If necessary, remove rear panel
knockouts for new boards. Boards plug into connectors as follows:
Option Board
Power supply
Relay board
Serial interface board
Analog output board
Signal conditioner board

Main Board Plug

Rear Panel Jack

P11
P12
P13
P14
P15

J1
J2
J3
J4
J5
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Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of the
main board and option board are aligned.
REASSEMBLING YOUR METER
Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, then carefully align
the board connectors with the openings in the rear panel. If necessary, remove any rear
panel knockouts for new option boards that may have been installed. Ensure that all option
boards are properly aligned with the molded board retaining pins on the inside of the rear
panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal plugs.
PANEL MOUNTING
Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the two
mounting screws counterclockwise until the space between the mounting pawl and the rear
of the gasket is greater than the panel thickness. Insert the meter in the panel cutout. Turn
the mounting screws clockwise until the meter is securely mounted in the panel. Do not
overtighten.

Dimensioned case drawings
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8. FRONT PANEL SETUP KEYS

Meter Front Panel
There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
right arrow, right
PEAK, RESET, ALARMS) for the Run Mode and with symbols (
left arrow) for the Menu Mode.
triangle, up triangle,
FRONT PANEL LOCKOUT
The Menu Mode will not work with most meters as received from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. That jumper needs to
be removed for the Menu Mode to work, and menu items under Loc 1, Loc 2 and Loc 3 then
need to be set to "0" via the front panel for these menu items to be unlocked See Section 9.
The paragraphs below assume that all menu items have been unlocked.
MENU MODE KEY ACTION
In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.
KEYS IN RUN MODE
MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.
PEAK Key. Pressing PEAK normally causes the peak value of the input signal to be
displayed. The peak display then blinks to differentiate it from the normal present value
display. Pressing PEAK again will return the display to the present value. The PEAK key
can also be programmed to display Valley, to display alternating Peak or Valley, or to
Tare the reading to zero. When Peak or Valley is selected, periodic horizontals bars at
the top of the display indicate Peak, and periodic horizontals bars at the bottom indicate
Valley.
RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
meter reset (same as power on). Meter reset can also be applied via a rear panel
connect or a serial ASCII command.
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ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.
KEYS IN MENU MODE
Right Arrow Key (MENU). Pressing
steps the meter through all menu items that
have been enabled and then back to the Run Mode. With the DC signal conditioner
board and no option boards, available menu items are _InPut, SEtuP, ConFG, _FiLtr,
dEc.Pt, SCALE, OFFst, Loc 1, Loc 2, Loc 3. If a change has been made to a menu
item, that change is saved to non-volatile memory when the
key is pressed next,
and StoreE is displayed briefly.
Right Triangle Key (Digit Select).
from the InPut menu brings up all meter functions available with the
• Pressing
meter's signal conditioner. For the DC signal conditioner, these are _dC U, _dC A
and _rAtio.
from the SEtuP, ConfFG, FiLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3
• Pressing
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit:
00000, 00000, 00000, 00000, 00000.
• Pressing
from the dEC.Pt menu item sequentially selects decimal point positions,
which will flash: d.dddd dd.ddd ddd.dd dddd.d ddddd. .ddddd.
Up Triangle Key (Value Select). Pressing for a flashing item (digit position or
decimal point position) will increment that item. Pressing MENU will save any changes.
Left Arrow Key (Reverse Menu). Pressing
has the same effect as the MENU key,
except that menu items are brought up in reverse order.
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9. ENABLING & LOCKING OUT MENU ITEMS
For security reasons and ease of meter operation, any and all menu
items may be disabled or "locked out" so that they are no longer
directly accessible from the front panel. Each function to be disabled
is set to "1" in menu items Loc 1, Loc 2 or Loc 3, and each function
to be enabled is set to "0." The top menu items Loc 1, Loc 2 and Loc
3 can in turn be locked out by installing an internal hardware jumper.
With the jumper installed, the operator only has access only to
enabled menu items. With the jumper removed, the operator also
has access to menu items Loc 1, Loc 2 and Loc 3.
SETTING HARDWARE LOCKOUT JUMPER
To access the lockout jumper, remove the rear panel per Section 9
and locate jumper “a” in the lower portion of the power supply board
next to the input connectors (see figure at right).
SETTING SOFTWARE LOCKOUTS
When setting up the meter, it may be necessary to
enable specific menu items by setting the corresponding lockout digit to 0. Be sure to reset the lockout
digit to "1" if you do not want the menu item to be
changed by an operator.
Loc 1 Loc 2 Loc 3
Press the
MENU key until Loc 1, Loc 2 or Loc 3
is displayed, as desired. Note: the hardware lockout
jumper must be removed (see above).
11111
Press to display the lockout status, consisting of
1’s and 0’s. The left digit will flash. Press again to
step to the next digit, which will flash.
00000
12345
Press to set the flashing digit to "0" to enable the
menu item or to "1" to disable. Press MENU to enter.
See the table to the right for list of menu items that
can be enabled or disabled.
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Enabled or Disabled
Menu Items
Loc 1
1 - Input type selection.
2 - Meter setup, configuration
& decimal pt.
4 - Filter selection.
5 - Scale or Lo, Hi input.
6 - Offset or Lo, Hi reading
Loc 2
2 - Alarm setup.
3 - Alarm setpoint
value programming.
4 - Analog output scaling.
5 - Serial interface setup.
Loc 3
2 - View peak value
3 - View alarm setpoints
4 - Reset (peak & latched alarms)
5 - Reset (meter reset)

10. READING COORDINATES OF 2 POINTS SCALING METHOD
When the reading coordinates of 2 points* scaling method has been selected under SEtuP,
the four menu items below will appear ahead of all other menu items when the MENU or
key is first pressed from the run mode.
This scaling method applies a straight line fit between two points, which are determined
from actual transducer signals and the desired corresponding meter readings. A low signal,
such as the output of a pressure transducer at zero pressure, and high signal, such as the
output of the same transducer at a known high pressure, are applied to the meter. The
desired corresponding low and high readings are then entered from the front panel. The
meter then applies straight line fit between the high and low calibration points. This scaling
method has the advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. This method is ideal for
process and load cell meters, which require zero and span adjustment. It is also available
for DC or AC meters. It is not available with thermocouple or RTD meters.
The programming example below is for a process meter used with a 4-20 mA pressure
transducer for 0 to 100 psi. Decimal points are set separately using the dEC.Pt menu.
Press Menu Select
Key

Press Digit Select
Key

Press Value Select
Key

Lo In Apply low signal input
(e.g., transducer output for 0
psi).

_40.21 Press
to display _40.21 Press
reading at low signal input reading.
(e.g., 4.021 mA).

to store low

Hi In Apply high signal input
(e.g., transducer output for
known 100.00 psi source).

200.94 Press
200.94 Press
to display reading.
reading at high signal input
(e.g., 20.094 mA).

to store high

Lo rd
Mode to enter desired low
reading (e.g., 0.00).

000.00 000.00 000.00
000.00 000.00 Select digit
to flash.

100.00 Select -9 thru 9 for
flashing first digit, 0 thru 9 for
other flashing digits.

Hi rd
Mode to enter desired high
reading (e.g., 100.00).

000.00 000.00 000.00
000.00 000.00 Select digit
to flash.

100.00 Select -9 thru 9 for
flashing first digit, 0 thru 9 for
other flashing digits.
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11. DC VOLTS, AMPS, PROCESS, STRAIN
The DC Volts, Amps, Process and Strain meters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Please see further manual sections for setup of the following:
relay output (15), analog output (16), communication I/O (17), parallel BCD output (18), and
transducer excitation output (19).
Voltage Ranges
FS Input

E1

E2

E3

B

±200.00 mV
±2.0000 V
±20.000 V
±200.00 V
±300V (UL)
±600V (not UL)

A
A
B
B
B
B

f
f
h
h
g
g

b
a
b
a
a
a

A

a

h
f

Current Ranges
FS Input

E1

E2

E3

±2.0000 mA
±20.000 mA
±200.00 mA
±5.000 A

A
A
A
A

e, g
d, g
c, g
a, b, g

b
b
b
b

E1
E3 E2

b

g
e

c

b

d

a

1. Use 5 mm (0.2") jumpers for locations designated by a capital letter.
2. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter.
3. Store spare jumpers on an unused jumper post not associated a capital letter.
SCALE & OFFSET SETUP
For DC voltmeters & ammeters, a scale factor of 1 and an offset of 0 are used for direct
readings in (milli)volts or (milli)amperes. Decimal point selection does not affect the displayed
digits. For example, 0-20V or 0-20 mA signals can both be displayed as 0-20000. A full scale
of 20000 may be displayed as 20.000 mA or 20000 µA. Use with a current shunt will require a
scale factor to be set. For example, for a 500-100 (500A, 100 mV) shunt, divide 5000 (the
desired full scale display with 0.1A resolution) by 10000 (displayed value with 100 mV when
the scale factor is 1.0) for a scale factor of 0.5.
For process & strain meters, scaling is normally set up from the front panel using the and
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1) Scale and
offset*, 2) Coordinates of 2 points*, and 3) Reading coordinates of 2 points*. Only menu items
applicable to the selected method will be presented. Please see the Glossary for an
explanation of items marked by an *.
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KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”
Press Menu
Select Key
_InPut
Selection of signal
input type & range

SEtuP
Meter Setup

Press Digit
Select Key

Press Value Select
Key

_dC U
DC Volts

__0.2U __2.0U _20.0U 200.0U 660.0U
0.2, 2, 20, 200, 660V FS

_dC A
DC Amps

__2.0a _20.0a _200.0a _5.0a
0.2, 20, 200 mA, 5A FS.

_rAtio
Strain gauge & ratio

__0.2U __2.0U _20.0U
0.2, 2, 20V FS.

00_00
Display selection with
scale factor of 1.

0
1
2
3

00 _00
Power line frequency

0 Noise minimized for 60 Hz
1 Noise minimized for 50 Hz

00_ 00
Scaling method

0 Scale and offset method*
1 Coordinates of 2 points method*
2 Reading coordinates of 2 points method*

00_00
Operation of control
inputs 1 & 2:
True = logic 1 (0V or
tied to digital ground)
False = 0 (5V or open)

0 1= Reset*, 2 = Meter Hold*
1 1= Function Reset*, 2 = Peak*or Valley*
2 1= Hold*, 2 = Peak or Valley Display
3 1= Hold*, 2 = Tare*
4 1= Peak or Valley Display, 2 = Tare*
5 1= Tare*, 2 = Reset*
6 1= 1, 2 = 1, decimal point = XXXXX
1= 0, 2 = 1, decimal point = XXXX.X
1= 1, 2 = 0, decimal point = XXX.XX
1= 0, 2 = 0, decimal point = XX.XXX
7 1= 1, 2 = 1, decimal point = XXXX.X
1= 0, 2 = 1, decimal point = XXX.XX
1= 1, 2 = 0, decimal point = XX.XXX
A = 0, 2 = 0, decimal point = X.XXX.X
8 1= Function Reset*, 2 = Display Blank*
9 1= Hold*, 2 = Display Blank
A 1 = Peak or Valley, 2 = Display Blank*
B 1 = Tare*, 2 = Display Blank*
C 1 = Valley Display, 2 = Peak Display
D 1 = Tare*, 2 = Reset Tare to Zero
Both inputs 1 and 2 set to 1 for selections
2, 4, A, C = Function Reset*
Both inputs 1 and 2 set to 1 for selections
0, 1, 3, 5, 8, 9, B, D = Meter Reset*
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4-1/2 digits (±20,000)
Remote display* (±99,999)
4-1/2 digits, counts by 10 (±20,000)
3-1/2 digits (±2,000)

Press Menu
Select Key

Press Digit
Select Key

ConFG
000 _0
Meter Configuration Operation as a rate of
change meter*.
Extended meter* only.

FiLtr
Filtering

Press Value Select
Key
0
1
2
3
4
5
6

Not rate of change
Rate x 0.1
Rate x 1
Rate x 10
Rate x 100
Rate x 1000
Rate x 10000

_0 _ _0
Operation of front
panel PEAK button
and rear connector for
Peak or Valley Display

0 Peak Display*. Also selects “Peak” in
“Peak or Valley” at connector above.
1 Valley Display*. Also selects “Valley” in
“Peak or Valley” at connector above.
2 Peak* (1st push), Valley* (2nd push)
3 Front panel Tare*

000 _ 0
Auto-tare

0 Meter comes up in normal run mode.
1 Meter comes up in auto-tare* mode

000 _ 0
Nonlinear input scaling
Extended meter* only.

0 Linear input
1 Custom curve linearization

00000
Alarm filtering

0 Unfiltered output
1 Filtered output

00000
Peak & Valley filtering

0 Unfiltered Peak* & Valley*
1 Filtered Peak* & Valley*

00000
Display filtering

0 Display batch average every 16 readings
1 Display filtered signal

00000 Adaptive filter
threshold

0 Low adaptive filter threshold level
1 High adaptive filter threshold level

00000
Input signal filtering.
Can be applied to display, setpoint, analog
output, data output.

0 Autofilter*
1 Batch average, 16 readings
2 Moving average*, 0.08 sec.
3 Moving average*, 0.15 sec.
4 Moving average*, 0.3 sec.
5 Moving average*, 0.6 sec.
6 Moving average*, 1.2 sec.
7 Moving average*, 2.4 sec.
8 Moving average*, 4.8 sec.
9 Moving average*, 9.6 sec.
A Unfiltered

dEc.Pt
d.dddd
Dec. point selection Decimal point flashes.

d.dddd dd.ddd ddd.dd dddd.d ddddd.
.ddddd Press
to shift the decimal point.
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

Scaling method “Scale and Offset” if selected under SEtuP
SCALE
Scale factor*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000 0.0000 for other flashing digits. Select decimal point
location when decimal point is flashing.
Select digit to flash.

OFFst
Offset value*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point
0.0000 0.0000
location
is selected by dEC.Pt.
Select digit to flash.

Scaling method “Coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal input.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by input range chosen.
Select digit to flash.

Lo rd
Desired reading at
Lo In.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by dEC.Pt.
Select digit to flash.

Hi In.
High signal input.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by input range chosen.
Select digit to flash.

Hi rd.
Desired reading at
Hi In.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by dEC.Pt.
Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal input.

_0.021
Apply a low reference
signal to the meter.

_0.021
Press to store the low signal input in the
meter.

Hi In.
High signal input.

_20.094
Apply a high reference
signal to the meter.

_0.021
Press to store the high signal input in the
meter.

Lo rd
Desired reading at
Lo In.

0.0000 0.0000 0.0000 0.0000
Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000
for other flashing digits. Decimal point is set
Select digit to flash.
by dEC.Pt.

Hi rd.
Desired reading at
Hi In.

0.0000 0.0000 0.0000 6.7500
Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000
for other flashing digits. Decimal point is set
Select digit to flash.
by dEC.Pt.
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Option board dependent menu items
ALSEt. dEU1H dEU2H dEU1b dEU2b
Menu items related to alarm setup These will only appear if a relay board is detected. If
so, please see Section15.
AnSEt. An Lo. An Hi..
Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.
SEr 1. SEr 2. SEr 3. SEr 4.
Menu items related to serial communications. These will only appear if an RS232 or
RS485 I/O board is detected. If so, see Section 17.
Menu lockout items
Loc 1. Loc 2. Loc 3.
Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
*

See Glossary for explanation of item.

** Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including _InPut. Decimal point is set by dEC.Pt.
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12. LOAD CELL & MICROVOLT INPUTS
The Load Cell and Microvolt meters utilize the load cell signal conditioner board, which offers
sensitivity to ±20 mV full scale and 4 or 6-wire load cell connection. This board needs to be
configured via jumpers for the desired voltage range. All signal ranges are factory calibrated
with calibration factors stored in EEPROM. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
Please see further manual sections for setup of the following features: relay output (15),
analog output (16), communication I/O (17), parallel BCD output (18), and transducer
excitation output (19).
RANGE SELECTION VIA JUMPERS
Ranges & Display with
Scale Factor = 1
Input
±20 mV
±50 mV
±100 mV
±250 mV
±500 mV
Notes

Jumpers
e
a
b
c
d

Full scale
display
±20000
±50000
±10000
±25000
±50000

1. See Section 19 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1 in).

SCALE & OFFSET SETUP
For DC microvolt meters, a scale factor of 1 and an offset of 0 are used for direct readings in
microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be displayed as 20.000 mV or 20000 µV. The decimal point is set
separately.
For load cell applications, scaling is normally set up from the front panel using the and
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1). Manual
scale and offset*, 2) Coordinates of 2 points*, and 3) Reading coordinates of 2 points*. Please
see the Glossary for an explanation of each method. Please see the Glossary for an
explanation of each method marked by an *.
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KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

_InPut
Selection of signal
input type & range

_Strn
Strain or ratiometric

_20.0_ __50.0_ _100.0 _250.0 _500.0
20, 50, 100, 250, 500 mV FS voltage

_dC U
DC millivolts

_20.0_ __50.0_ _100.0 _250.0 _500.0
20, 50, 100, 250, 500 mV FS voltage

SEtuP
Meter Setup

00_00
Display type

0
1
2
3

00 _00
Power line frequency

0 Noise minimized for 60 Hz
1 Noise minimized for 50 Hz

00_ 00
Scaling method

0 Scale and offset method*
1 Coordinates of 2 points method*
2 Reading coordinates of 2 points method*

00_00
Operation of control
inputs 1 & 2:
True = logic 1 (0V or
tied to digital ground)
False = 0 (5V or open)

0 1= Reset*, 2 = Meter Hold*
1 1= Function Reset*, 2 = Peak*or Valley*
2 1= Hold*, 2 = Peak or Valley Display
3 1= Hold*, 2 = Tare*
4 1= Peak or Valley Display, 2 = Tare*
5 1= Tare*, 2 = Reset*
6 1= 1, 2 = 1, decimal point = XXXXX
1= 0, 2 = 1, decimal point = XXXX.X
1= 1, 2 = 0, decimal point = XXX.XX
1= 0, 2 = 0, decimal point = XX.XXX
7 1= 1, 2 = 1, decimal point = XXXX.X
1= 0, 2 = 1, decimal point = XXX.XX
1= 1, 2 = 0, decimal point = XX.XXX
1= 0, 2 = 0, decimal point = X.XXX.X
8 1= Function Reset*, 2 = Display Blank*
9 1= Hold*, 2 = Display Blank
A 1 = Peak or Valley, 2 = Display Blank*
B 1 = Tare*, 2 = Display Blank*
C 1 = Valley Display, 2 = Peak Display
D 1 = Tare*, 2 = Reset Tare to Zero
-----------------------------------------------------------Both inputs 1 and 2 set to 1 for selections
2, 4, A, C = Function Reset*
Both inputs 1 and 2 set to 1 for selections
0, 1, 3, 5, 8, 9, B, D = Meter Reset*
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4-1/2 digit meter, counts by 1
5-digit remote display* (±99,999)
4-1/2 digit meter, counts by 10
3-1/2 digit meter

Press Menu
Select Key

Press Digit
Select Key

ConFG
000_0
Meter Configuration Operation as a rate of
change meter*.
Extended meter* only.

FiLtr
Filtering

Press Value Select
Key
0
1
2
3
4
5
6

Not rate of change
Rate x 0.1
Rate x 1
Rate x 10
Rate x 100
Rate x 1000
Rate x 10000

000_0
Operation of front
panel PEAK button
and rear connector for
Peak or Valley Display

0 Peak Display*. Also selects “Peak” in
“Peak or Valley” at connector above.
1 Valley Display*. Also selects “Valley” in
“Peak or Valley” at connector above.
2 Peak* (1st push), Valley* (2nd push)
3 Front panel Tare*

000 _0
Auto-tare

0 Meter comes up in normal run mode.
1 Meter comes up in auto-tare* mode

000_ 0
Nonlinear input scaling
Extended meter* only.

0 Linear input
1 Custom curve linearization

00000
Alarm filtering

0 Unfiltered output
1 Filtered output

00000
Peak & Valley filtering

0 Unfiltered Peak* & Valley*
1 Filtered Peak* & Valley*

00000
Display filtering

0 Display batch average every 16 readings
1 Display filtered signal

00000 Adaptive filter
threshold

0 Low adaptive filter threshold level
1 High adaptive filter threshold level

00000
Input signal filtering.
Can be applied to display, setpoint, analog
output, data output.

0 Autofilter*
1 Batch average, 16 readings
2 Moving average*, 0.08 sec.
3 Moving average*, 0.15 sec.
4 Moving average*, 0.3 sec.
5 Moving average*, 0.6 sec.
6 Moving average*, 1.2 sec.
7 Moving average*, 2.4 sec.
8 Moving average*, 4.8 sec.
9 Moving average*, 9.6 sec.
A Unfiltered

dEc.Pt
d.dddd
Dec. point selection Decimal point flashes.

d.dddd dd.ddd ddd.dd dddd.d ddddd.
.ddddd
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

Scaling method “Scale and Offset” if selected under SEtuP
SCALE
Scale factor*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000 0.0000 for other flashing digits. Select decimal point
location when decimal point is flashing.
Select digit to flash.

OFFst
Offset value*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point
0.0000 0.0000
location
is selected by dEC.Pt.
Select digit to flash.

Scaling method “Coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal input.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by input range chosen.
Select digit to flash.

Lo rd
Desired reading at
Lo In.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by dEC.Pt.
Select digit to flash.

Hi In.
High signal input.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by input range chosen.
Select digit to flash.

Hi rd.
Desired reading at
Hi In.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by dEC.Pt.
Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal input.

_0.021
Apply a low reference
signal to the meter.

_0.021
Press to store the low signal input in the
meter.

Hi In.
High signal input.

_20.094
Apply a high reference
signal to the meter.

_0.021
Press to store the high signal input in the
meter.

Lo rd
Desired reading at
Lo In.

0.0000 0.0000 0.0000 0.0000
Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000
for other flashing digits. Decimal point is set
Select digit to flash.
by dEC.Pt.

Hi rd.
Desired reading at
Hi In.

0.0000 0.0000 0.0000 6.7500
Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000
for other flashing digits. Decimal point is set
Select digit to flash.
by dEC.Pt.
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Option board dependent menu items
ALSEt. dEU1H dEU2H dEU1b dEU2b
Menu items related to alarm setup These iwill only appear if a relay board is detected. If
so, please see Section15.
AnSEt. An Lo. An Hi..
Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.
SEr 1. SEr 2. SEr 3. SEr 4.
Menu items related to serial communications. These will only appear if an RS232 or
RS485 I/O board is detected. If so, see Section 17.
Menu lockout items
Loc 1. Loc 2. Loc 3.
Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
* See Glossary for explanation of item.
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13. AC RMS VOLTS & AMPS
The AC RMS Voltmeters and Ammeters utilize an AC signal conditioner board with precision
circuitry to compute the root-mean-square of complex waveforms from 10 Hz to 10 kHz.
Spikes up to 2.4 times the maximum of each range are accurately measured. The input is AC
coupled to read only the AC component, such as ripple on a power supply. The board needs to
be configured via jumpers for the desired voltage or current range. All signal ranges are factory
calibrated with calibration factors stored in EEPROM. The meter software recognizes the
board and will bring up the appropriate menu items for it; however, it does not recognize the
jumper settings which set the ranges. These need to be entered manually. Please see further
manual sections for setup of the following features: relay output (15), analog output (16),
communication I/O (17), parallel BCD output (18), and transducer excitation output (19).
Voltage Ranges
Full Scale Input
200 mV
2V
20V
200V
300V (UL)
600V (not UL)

Counts

Jumpers

20000
20000
20000
20000
3000
6000

g, k
g, j
h, k
h, j
f, j
f, j

Counts

Jumpers

20000
20000
20000
5000

e, f, k
d, f, k
c, f, k
a, b, f, m

Current Ranges
Full Scale Input
2 mA
20 mA
200 mA
5A

RANGE SELECTION VIA JUMPERS
1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on unused jumper post.

METER SCALING
Refer to the above tables for the full scale counts (or displayed digits) produced by the
available full scale input ranges with a scale factor of 1 and an offset of 0. The decimal point
can be set for direct readout in (milli)volts or (milli)amperes. Decimal point selection does not
affect the counts. For example, a 20V input may be displayed as 20.000V or 20000 mV.
The 5A range, designed for use with a 5A current transformer (CT), is scaled to produce 5000
counts with a scale factor of 1 and an offset of 0. Use with a specific CT will require the scale
factor to be set. For example, for an 800A input, 5A output CT, set a scale factor of 1.6. This is
the desired 8000 count display at 5A divided by the default 5000 count display at 5A. Then set
the decimal point to display to 800.0 at 5A.
All scaling methods applicable to DC, process, strain and load cell meters are available with
AC RMS meters. Readings below 10 counts are displayed as 0.
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KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
Select Key
_InPut
Selection of signal
input type & range

SEtuP
Meter Setup

Press Digit
Select Key

Press Value Select
Key

_AC U
Strain or ratiometric

__0.2U __2.0U _20.0U 200.0U 660.0U
0.2, 2, 20, 200, 660V FS

_AC A
DC millivolts

__2.0a _20.0a _200.0a _5.0a
0.2, 20, 200 mA, 5A FS.

00_00
Display selection with
scale factor of 1

0
1
2
3

00 _00
Power line frequency

0 Noise minimized for 60 Hz
1 Noise minimized for 50 Hz

00_ 00
Scaling method

0 Scale and offset method*
1 Coordinates of 2 points method*
2 Reading coordinates of 2 points method*

00_00
Operation of control
inputs 1 & 2.
True = logic 1 (0V or
tied to digital ground)
False = 0 (5V or open)

0 1 = Reset*, 2 = Meter Hold*
1 1 = Function Reset*, 2 = Peak*or Valley*
2 1 = Hold*, 2 = Peak or Valley Display
3 1 = Hold*, 2 = Tare*
4 1 = Peak or Valley Display, 2 = Tare*
5 1 = Tare*, 2 = Reset*
6 1 = 1, 2 = 1, decimal point = XXXXX
1= 0, 2 = 1, decimal point = XXXX.X
1= 1, 2 = 0, decimal point = XXX.XX
1= 0, 2 = 0, decimal point = XX.XXX
7 1 = 1, 2 = 1, decimal point = XXXX.X
1= 0, 2 = 1, decimal point = XXX.XX
1= 1, 2 = 0, decimal point = XX.XXX
1= 0, 2 = 0, decimal point = X.XXX.X
8 1 = Function Reset*, 2 = Display Blank*
9 1 = Hold*, 2 = Display Blank
A 1 = Peak or Valley, 2 = Display Blank*
B 1 = Tare*, 2 = Display Blank*
C 1 = Valley Display, 2 = Peak Display
D 1 = Tare*, 2 = Reset Tare to Zero
-----------------------------------------------------------Both inputs 1 and 2 set to 1 for selections
2, 4, A, C = Function Reset*
Both inputs 1 and 2 set to 1 for selections
0, 1, 3, 5, 8, 9, B, D = Meter Reset*
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4-1/2 digits (±20,000)
Remote display* (±99,999)
4-1/2 digits, counts by 10 (±20,000)
3-1/2 digits (±2,000)

Press Menu
Select Key

Press Digit
Select Key

ConFG
000_0
Meter Configuration Operation as a rate of
change meter*.
Extended meter* only.

FiLtr
Filtering

Press Value Select
Key
0
1
2
3
4
5
6

Not rate of change
Rate x 0.1
Rate x 1
Rate x 10
Rate x 100
Rate x 1000
Rate x 10000

00 _ _0
Operation of front
panel PEAK button
and rear connector for
Peak or Valley Display

0 Peak Display*. Also selects “Peak” in
“Peak or Valley” at connector above.
1 Valley Display*. Also selects “Valley” in
“Peak or Valley” at connector above.
2 Peak* (1st push), Valley* (2nd push)
3 Front panel Tare*

000 _0
Auto-tare

0 Meter comes up in normal run mode.
1 Meter comes up in auto-tare* mode

000_ 0
Nonlinear input scaling
Extended meter* only.

0 Linear input
1 Custom curve linearization

00000
Alarm filtering

0 Unfiltered output
1 Filtered output

00000
Peak & Valley filtering

0 Unfiltered Peak* & Valley*
1 Filtered Peak* & Valley*

00000
Display filtering

0 Display batch average every readings
1 Display filtered signal

00000 Adaptive filter
threshold

0 Low adaptive filter threshold level
1 High adaptive filter threshold level

00000
Input signal filtering.
Can be applied to display, setpoint, analog
output, data output.

0 Autofilter*
1 Batch average, 16 readings
2 Moving average*, 0.08 sec.
3 Moving average*, 0.15 sec.
4 Moving average*, 0.3 sec.
5 Moving average*, 0.6 sec.
6 Moving average*, 1.2 sec.
7 Moving average*, 2.4 sec.
8 Moving average*, 4.8 sec.
9 Moving average*, 9.6 sec.
A Unfiltered

dEc.Pt
d.dddd
Dec. point selection Decimal point flashes.

d.dddd dd.ddd ddd.dd dddd.d ddddd.
.ddddd
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

Scaling method “Scale and Offset” if selected under SEtuP
SCALE
Scale factor*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000 0.0000 for other flashing digits. Select decimal point
location when decimal point is flashing.
Select digit to flash.

OFFst
Offset value*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point
0.0000 0.0000
location
is selected by dEC.Pt.
Select digit to flash.

Scaling method “Coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal input.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by input range chosen.
Select digit to flash.

Lo rd
Desired reading at
Lo In.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by dEC.Pt.
Select digit to flash.

Hi In.
High signal input.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by input range chosen.
Select digit to flash.

Hi rd.
Desired reading at
Hi In.

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set
0.0000 0.0000
by dEC.Pt.
Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal input.

_0.021
Apply a low reference
signal to the meter.

_0.021
Press to store the low signal input in the
meter.

Hi In.
High signal input.

_20.094
Apply a high reference
signal to the meter.

_0.021
Press to store the high signal input in the
meter.

Lo rd
Desired reading at
Lo In.

0.0000 0.0000 0.0000 0.0000
Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000
for other flashing digits. Decimal point is set
Select digit to flash.
by dEC.Pt.

Hi rd.
Desired reading at
Hi In.

0.0000 0.0000 0.0000 6.7500
Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000
for other flashing digits. Decimal point is set
Select digit to flash.
by dEC.Pt.
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Option board dependent menu items
ALSEt. dEU1H dEU2H dEU1b dEU2b
Menu items related to alarm setup These iwill only appear if a relay board is detected. If
so, please see Section15.
AnSEt. An Lo. An Hi..
Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.
SEr 1. SEr 2. SEr 3. SEr 4.
Menu items related to serial communications. These will only appear if an RS232 or
RS485 I/O board is detected. If so, see Section 17.
Menu lockout items
Loc 1. Loc 2. Loc 3.
Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
*

See Glossary for explanation of item.

** Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including _InPut. Decimal point is set by dEC.Pt.

29

14. TEMPERATURE: THERMOCOUPLE & RTD
Thermocouple and RTD meters utilize the temperature signal conditioner board, which can be
configured via jumpers for 7 thermocouple types (J, K, T, E, N, S, R) and 2 Pt 100 RTD types
(DIN with temperature coefficient of 0.00385 ohms/ohm/°C or ANSI with temperature coefficient of 0.003925 ohms/ohm/°C). All signal ranges are factory calibrated. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Display in °C or °F and resolution of 1°, 0.1° or 0.01° are user
programmable. High resolution should only be used for relative readings, not absolute
readings. Although available, 0.01° resolution is not recommended for thermocouples.
The addition of a relay output board turns the meter from a temperature indicator into a
temperature controller. Please see further manual sections for setup of the following features:
relay output (Section 15), analog output (16), communication I/O (17), parallel BCD output
(18), and transducer excitation output (19).
SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS
Thermocouples
Type

Jumpers

J, K, E, N
T, R, S
Open Indication

e
f
Jumpers

Upscale
Downscale

c
d

Pt 100 RTD connection
Connection

Jumpers

2- or 4-wire
3-wire

b, e
a, e

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.
SCALE & OFFSET SETUP
Scale is available for RTDs (but not thermocouples) and is normally set to 1.0000. Scale can
be used as an adjustment when actual resistance is other than 100 ohms, as stated on the
RTD calibration sheet. To calculate scale, divide 100 by the stated resistance at 0°C. For
example, for a 99.04 ohm RTD, scale should be set to 100 / 99.04 = 1.0097.
Offset is available for thermocouples and RTDs, and is normally set to 0000.0. If °C is
selected, entering an offset of 0273.2 will change the display to Kelvin. If °F is selected,
entering 0459.7 will change the display to Rankine.
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RTD CONNECTION
With the appropriate a, b, e jumper positions,
the RTD meter allows 2, 3 or 4-wire RTD
hookup to the J5 connector, as illustrated.
The meter applies an excitation current of 0.2
mA, which it monitors to make ratiometric
corrections for excitation supply variations.
In 2-wire hookup, the meter senses the
voltage drop across the 100 ohm RTD and
both lead wires. The effect of the lead wires
can be measured and subtracted by shorting
out the RTD during meter setup. The short
should be as close as possible to the RTD.
Ambient temperature changes will still cause
some error in the readings -- the higher the
lead resistance, the greater the error.
2-wire lead resistance compensation
Under the .Short. menu selection, the two
key is
RTD leads are shorted out, the
pushed, a value proportional to lead resistance is displayed, and that value is automatically stored in the meter. After this step, DIN or ANSI and °F or °C need to be selected.
In 3-wire hookup, the meter automatically compensates for lead resistance by measuring the
voltage drop in one current carrying lead and assuming that the other current carrying lead is
the same.
In 4-wire hookup, no compensation for lead resistance is necessary. The step of shorting out
the RTD during meter setup is not necessary with either 3 or 4-wire hookup.
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KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
Select Key
_InPut
Selection of signal
input type & range

Press Digit
Select Key
__tC_
Thermocouple

Press Value Select
Key
--.J °F_
...K °F_
...n °F_
_.E °F_
__t °F _
_.S °F_
_.r °F_
.

SEtuP
Meter Setup

_.J °C_
_K-°C_
_-n °C_
...Ek°C_.t °C_
_.S °C_
_.r °C._

Type J, °F or °C
Type K, °F or °C
Type N, °F or °C
Type E, °F or °C
Type T, °F or °C
Type S, °F or °C
Type R, °F or °C

_-rtd_
Pt 100 ohm RTD

..4d °F- ..4d °C- 4-wire DIN , °F or °C
..4A °F. ..4A °C- 4-wire ANSI, °F or °C
..3d °F- ..3d °C- 3-wire DIN, °F or °C
..3A °F. ..3A °C- 3-wire ANSI, °F or °C
..2d °F- ..2d °C- 2-wire DIN, °F or °C
..2A °F. ..2A °C- 2-wire ANSI, °F or °C
.Short.. 2-wire lead resistance compensato reset
tion. After selecting Short, press
the meter, short the two leads adjacent to
the RTD, and press to automatically store
a value proportional to lead resistance. After
that, go back to select
..2d °F- ..2d °C- ..2A °F. or ..2A °C-.

00_00
Display selection with
scale factor of 1.

0
1
2
3

00 _00
Power line frequency

0 Noise minimized for 60 Hz
1 Noise minimized for 50 Hz

00_ 00
Scaling method

0 Scale and offset method* for RTDs,
offset only for thermocouples

00_00
Operation of control
inputs 1 & 2:
True = logic 1 (0V or
tied to digital ground)
False = 0 (5V or open)

01
11
21
31
41
51
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0.1 degree resolution
Remote display* (±99,999)
0.01 degree resolution
1 degree resolution

= Reset*, 2 = Meter Hold*
= Function Reset*, 2 = Peak*or Valley*
= Hold*, 2 = Peak or Valley Display
= Hold*, 2 = Tare*
= Peak or Valley Display, 2 = Tare*
= Tare*, 2 = Reset*

Press Menu
Select Key
SEtuP
Meter Setup
(continued)

Press Digit
Select Key
00_00
Operation of control
inputs 1 & 2:
(continued)

ConFG
000_0
Meter Configuration Operation as a rate of
change meter*.
Extended meter* only.

FiLtr
Filtering

Press Value Select
Key
6 1 = 1, 2 = 1, decimal point = XXXXX
1 = 0, 2 = 1, decimal point = XXXX.X
1 = 1, 2 = 0, decimal point = XXX.XX
1 = 0, 2 = 0, decimal point = XX.XXX
7 1 = 1, 2 = 1, decimal point = XXXX.X
1 = 0, 2 = 1, decimal point = XXX.XX
1 = 1, 2 = 0, decimal point = XX.XXX
1 = 0, 2 = 0, decimal point = X.XXX.X
8 1 = Function Reset*, 2 = Display Blank*
9 1 = Hold*, 2 = Display Blank
A 1 = Peak or Valley, 2 = Display Blank*
B 1 = Tare*, 2 = Display Blank*
C 1 = Valley Display, 2 = Peak Display
D 1 = Tare*, 2 = Reset Tare to Zero
-----------------------------------------------------------Both inputs 1 and 2 set to 1 for selections
2, 4, A, C = Function Reset*
Both inputs 1 and 2 set to 1 for selections
0, 1, 3, 5, 8, 9, B, D = Meter Reset*
0
1
2
3
4
5
6

Not rate of change
Rate x 0.1
Rate x 1
Rate x 10
Rate x 100
Rate x 1000
Rate x 10000

00 _ _0
Operation of front
panel PEAK button
and rear connector for
Peak or Valley Display

0 Peak Display*. Also selects “Peak” in
“Peak or Valley” at connector above.
1 Valley Display*. Also selects “Valley” in
“Peak or Valley” at connector above.
2 Peak* (1st push), Valley* (2nd push)
3 Front panel Tare*

00000
Alarm filtering

0 Unfiltered output
1 Filtered output

00000
Peak & Valley filtering

0 Unfiltered Peak* & Valley*
1 Filtered Peak* & Valley*

00000
Display filtering

0 Display batch average every 16 readings
1 Display filtered signal

00000 Adaptive filter
threshold

0 Low adaptive filter threshold level
1 High adaptive filter threshold level
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

FiLtr
Filtering
(continued)

00000
Input signal filtering.
Can be applied to display, setpoint, analog
output, data output.

0 Autofilter*
1 Batch average, 16 readings
2 Moving average*, 0.08 sec.
3 Moving average*, 0.15 sec.
4 Moving average*, 0.3 sec.
5 Moving average*, 0.6 sec.
6 Moving average*, 1.2 sec.
7 Moving average*, 2.4 sec.
8 Moving average*, 4.8 sec.
9 Moving average*, 9.6 sec.
A Unfiltered

dEc.Pt
Dec. point selection

d.dddd
Decimal point flashes.

d.dddd dd.ddd ddd.dd dddd.d ddddd.

SCALE
Scale factor*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
0.0000 0.0000 0.0000 for other flashing digits. Select decimal point
location when decimal point is flashing.
Select digit to flash.

OFFst
Offset value*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Use offset for display
0.0000 0.0000
in Rankine or Kelvin. Decimal point location
Select digit to flash.
is selected by dEC.Pt.

.ddddd

Option board dependent menu items
ALSEt. dEU1H dEU2H dEU1b dEU2b
Menu items related to alarm setup These will only appear if a relay board is detected. If
so, please see Section15.
AnSEt. An Lo. An Hi..
Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.
SEr 1. SEr 2. SEr 3. SEr 4.
Menu items related to serial communications. These will only appear if an RS232 or
RS485 I/O board is detected. If so, see Section 17.
Menu lockout items
Loc 1. Loc 2. Loc 3.
Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
* See Glossary for explanation of item.
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15. DUAL RELAY OUTPUT OPTION
An optional dual contact relay board or dual solid state relay board may be may be installed in
the meter main board at plug position P12, adjacent to the power supply board. Once installed,
the relay board is recognized by the software, which will bring up the appropriate menu items.
These menu items will not be brought up if a relay board is not installed. Both relay boards
offer a choice of operating modes: latched* or non-latched*, hysteresis band*, deviation band*,
actuation based on the filtered or unfiltered signal, and selectable number of readings in alarm
zone to cause an alarm. Please see the Glossary at the end of this manual for an explanation
of terms marked by an *.
KEYSTROKES FOR VIEWING & CHANGING SETPOINTS
It is not necessary to enter the setup menu to view or change setpoints. This allows the meter
to continue conversions and provide outputs when setpoints are displayed. After pressing
(Alarms), you have 30 seconds to enter a change, or the meter reverts to normal display.
Press Alarms
Key

Press Digit
Select Key

Press Value Select
Key

300.24
_200.00
Press
(Alarms) to
Current setpoint 1 value blinks,
display Alarm 1 setpoint. and Alarm 1 LED indicator
lights. Press to select a digit,
which will blink.

_295.00
To change setpoint 1 value,
press to change selected
blinking digits.

395.00
_395.00
Press
(Alarms) to
Current setpoint 2 value blinks,
display Alarm 2 setpoint. and Alarm 2 LED indicator
lights. Press to select a digit,
which will blink.

_305.00
To change setpoint 2 value,
press to change selected
blinking digits.

300.24 Press

(Alarms) again. The meter will reset and display the current reading.

KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”
Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

ALSEt
Alarm Setup.
Press
until
ALSEt is displayed
(with relay board).

00000
Relay state when
alarm is active.

0
1
2
3

Relay 1 on
Relay 1 off
Relay 1 on
Relay 1 off

Relay 2 on
Relay 2 on
Relay 2 off
Relay 2 off

00000
Alarm latching* or nonlatching* (auto reset).

0
1
2
3

Alarm 1 auto reset
Alarm 1 latching
Alarm 1 auto reset
Alarm 1 latching

Alarm 2 auto reset
Alarm 2 auto reset
Alarm 2 latching
Alarm 2 latching
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Press Menu
Select Key
ALSEt
Alarm Setup.
(continued)

Press Digit
Select Key

Press Value Select
Key

00000
Alarm operates at and
above setpoint (active
high) or at and below
setpoint (active low).

0
1
2
3
4
5
6
7
8

AL1 active high
AL1 active low
AL1 disabled
AL1 active high
AL1 active low
AL1 disabled
AL1 active high
AL1 active low
AL1 disabled

00000
Hysteresis mode* or
band deviation mode*

0
1
2
3
4

AL1 band deviation AL2 band deviation
AL1 hysteresis
AL2 band deviation
AL1 band deviation AL2 hysteresis
AL1 hysteresis
AL2 hysteresis
No deviation or hysteresis in menu.

00000
Number of readings in
alarm zone to cause
an alarm.

0
1
2
3
4
5
6
7

After 1 reading
After 2 readings
After 4 readings
After 8 readings
After 16 readings
After 32 readings
After 64 readings
After 128 readings

AL2 active high
AL2 active high
AL2 active high
AL2 active low
AL2 active low
AL2 active low
AL2 disabled
AL2 disabled
AL2 disabled

dEU1H
0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
Alarm 1 hysteresis* 0.0000 0.0000
for other flashing digits. Alarms will operate
above and below the setpoint by the value
Select digit to flash.
entered (half of hysteresis band).
DEU2H
0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
Alarm 2 hysteresis* 0.0000 0.0000
for other flashing digits. Alarms will operate
above and below the setpoint by the value
Select digit to flash.
entered (half of hysteresis band).
DEU1b
Alarm 1 deviation*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Alarms will operate
0.0000 0.0000
above and below the setpoint by the value
Select digit to flash.
entered (half of deviation band).

DEU2b
Alarm 2 deviation*

0.0000 0.0000 0.0000 Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Alarms will operate
0.0000 0.0000
above and below the setpoint by the value
Select digit to flash.
entered (half of deviation band).

* See Glossary for explanation of item.
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16. ANALOG OUTPUT OPTION
An optional analog board may be may be connected to the meter main board at plug position
P14, adjacent to the signal conditioner board. Once installed, the analog output board is
recognized by the meter, which will bring up the appropriate menu items. These items will not
be brought up if an analog output board is not installed.
Both current (0-20 mA or 4-20 mA) and voltage (0-10 Vdc)
analog outputs are selectable at connector P4. One of three
analog output spans (0-20 mA, 4-20 mA or 0-10 Vdc) may be
selected in software for scaling. The low analog output (0 mA,
4 mA or 0V) may be set to correspond to any low displayed
reading An Lo. The corresponding high analog output (20 mA
or 10V) may be set to correspond to any high displayed reading An Hi. The meter will then
apply a straight line fit between these two end points, thereby providing an analog output
scaled to the displayed reading for the selected span.
Although both current and voltage outputs are available at connector P4, only one is calibrated
to specifications. If the calibrated output is 0-10V, the non-calibrated output is 0-20 mA. If the
calibrated output is 0-20 mA, the non-calibrated output is 0-10V. Both of these non-calibrated
outputs are accurate to 1% typical, 2% max. If the calibrated output is 4-20 mA, the noncalibrated output is 2.5-10V.
KEYSTROKES FOR SETUP
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”
If the MENU

Press Menu
Select Key

Press Digit Select
Key

Press Value Select
Key

AnSEt
Analog Output Setup.
Press
until AnSEt
is displayed (requires
analog output board).

00___
0 0-20 mA current output
Selection of calibrated output. 1 0-10V voltage output
2 4-20 mA current output
00___
Analog output filtering.

0 Analog output unfiltered
1 Analog output filtered

An Lo
Low displayed value
for 0 mA, 4 mA or 0V
output

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first
digit, 0 thru 9 for other flashing
digits. Decimal point location is
fixed by dEC.Pt selection.

An Hi.
High displayed value
for 20 mA or 10V output

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first
digit, 0 thru 9 for other flashing
digits. Decimal point location is
fixed by dEC.Pt selection.
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17. SERIAL COMMUNICATION OPTIONS
An optional serial communications board (RS232, RS485 or RS485-Modbus) may be connected to the meter main board at plug position P13 (middle position). Once installed, this
board is recognized by the meter, which will bring up the appropriate serial communication
menu items. These items will not be brought up if a communication board is not installed.
The RS485 and RS485-Modbus boards are electrically equivalent, but have a slightly different
physical layout. The RS485 version uses two RJ11 connectors, while the RS485-Modbus
version uses two RJ45 connectors for compliance with the Modbus standard. Both boards
feature dual connectors, which are wired in parallel to allow daisy chaining of addressable
meters with no need for a communications hub. All three boards are compatible with the same
serial three communication protocols, which are selectable under meter setup: Custom ASCII*,
Modbus* RTU, and Modbus* ASCII. Digital addressing of multiple meters on the same serial
communication line requires RS485 or RS485-Modbus boards.
BOARD SETUP VIA JUMPERS
RS232 Board
g - Normal operation.
h - Slave display operation to RS232 output
of another meter.
J - Pull-up resistor on RTS line.
Note: The board is shipped standard with jumpers
g and j installed.
RS485 and RS485-Modbus Boards
Full Duplex Operation
b & e - These bias jumpers should be installed on
1 (and only 1) meter.
a & d - installed on last meter in line with long
cable runs.
Half Duplex Operation
b & e - bias jumpers installed on 1 board.
c & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs.
Note: The boards are shipped standard with no
jumpers installed.
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KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
Select Key
.SEr 1.
Fixed Parameters:
No parity
8 data bits
1 stop bit

Press Digit Select
Key
__000
Output filtering

0 Send unfiltered signal
1 Send filtered signal

__000
Baud rate

0
1
2
3
4
5
6

300 baud
600 baud
1200 baud
2400 baud
4800 baud
9600 baud
19200 baud

0
1
2
3
4
5
6
7
8
9

60 Hz
Line frequency
0.28 sec
0.57 sec
1.1 sec
2.3 sec
4.5 sec
9.1 sec
18.1 sec
36.6 sec
72.5 sec

__000
Output update rate

.SEr 2.
Serial Setup 2

.SEr 3.
Serial Setup 3

Press Value Select
Key

50 Hz
Line frequency
0.34 sec
0.68 sec
1.4 sec
2.7 sec
5.4 sec
10.9 sec
21.8 sec
43.5 sec
97 sec

_0000
Line feed

0 No line feed after carriage return
1 Line feed after carriage return

_0000
Alarm data with readings

0 No alarm data
1 Alarm data with reading

_0000
Control of data output

0 Continuous data output
1 Data output on ASCII command only

_0000
Meter address with Custom
ASCII protocol*

Select 0 thru F for addresses 1 thru 15.
Select 0. thru F. (with decimal point) for
addresses 16 thru 31.

00000
Half or full duplex

0 Full duplex
1 Half duplex

00000
Special start & stop char.

0 Standard continuous mode
1 Special start & stop characters

00000
RTS mode

0 Normal RTS
1 Single transmission

00000
Termination characters

0 Only at end of all items
1 At end of each item
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Press Menu
Select Key

Press Digit Select
Key

Press Value Select
Key

.SEr 3.
Serial Setup 3
(continued)

00000
Data sent in continuous
mode

0
1
2
3
4
5

Reading
Peak
Valley
Reading + peak
Reading + valley
Reading + peak + valley

SEr 4.
Serial Setup 4

__000
Modbus* ASCII gap timeout

0
1
2
3

1 sec
3 sec
5 sec
10 sec

__000
Serial protocol

0 Custom ASCII*
1 Modbus* RTU
2 Modbus* ASCII

__000
Parity

0 None
1 Odd
2 Even

__000 __000 __000
Select digit to flash.

__158
Select 0 through 9 for flashing digit.
Address range is 1 to 247.

_Addr
Modbus Address

* See Glossary for explanation of item.
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18. PARALLEL BCD OUTPUT OPTION
An optional parallel BCD output board may be connected to the meter main board at plug
position P13 (middle position). Once installed, the board is recognized by the meter, which
will bring up the appropriate menu items. The BCD board provides isolated, buffered,
stored, 3-state parallel outputs that are jumper selectable for either 0-5V logic (LSTTL,
CMOS compatible) or 0-15V dc. BCD outputs are positive true. Polarity bit is positive true
for +sign.
Logic Level
0 to 5 Vdc
0 to 15 Vdc

Jumper
b
a

BCD CONTROL SIGNALS
Enable

Logic 0 - All outputs go to high impedance state.
Logic 1 - BCD information is
available at outputs.

/ BCD Hold Logic 0 - BCD from last update prior to
BCD Hold going low is stored.
Logic 1 - BCD information is
updated at selected rate.
/ Data Ready Logic 0 - BCD outputs are valid. Logic
1 - BCD outputs are not valid.

KEYSTROKES FOR SETUP
key does not work, see Section 9 “Enabling & Locking Out Menu Items.”
If the MENU
Press Menu
Select Key
_SEr 1
Press
until
SEr 1 is displayed.

Press Digit
Select Key

Press Value Select
Key
0 Send unfiltered signal
1 Send filtered signal

__0_0
Output filtering
__0_0
Output update rate

0
1
2
3
4
5
6
7
8
9
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60 Hz
Line frequency
0.28 sec
0.57 sec
1.1 sec
2.3 sec
4.5 sec
9.1 sec
18.1 sec
36.6 sec
72.5 sec

50 Hz
0.34 sec
0.68 sec
1.4 sec
2.7 sec
5.4 sec
10.9 sec
21.8 sec
43.5 sec
97 sec

19. EXCITATION OUTPUTS & POWER SUPPLY
Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated. In
addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (95-240 Vac ±10% and 95-300 Vdc ±10%) and to
the low voltage power supply (10-34 Vac & 10-48 Vdc).

Excitation output

Jumper locations

5 Vdc ±5%, 100 mA max

b, d, e

10 Vdc ±5%, 120 mA max

b, d, f

24 Vdc ±5%, 50 mA max

c

SELECTION OF OTHER JUMPERS
Jumper a
Jumper g
Jumper h

-

Front panel menu lockout, locked when installed. See Section 9)
Provides +5V power output at P1-4 when installed.
Connects "Control Input 2" to P1-4 when installed.
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20. INSTRUMENT SETUP VIA PC
Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.
SOFTWARE INSTALLATION
Download IS2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.
PREREQUISITES FOR CONNECTED USE
1) PC with available RS232 com port.
2) Meter to be set up.
3) RS232 board in the meter. This board can be
used for meter setup, then be removed.
4) RJ11-to-DB9 RS232 cable to connect the meter
and PC (see Section 1, Ordering Guide).
5) Instrument Setup software.
ESTABLISHING COMMUNICATIONS
Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => IS2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select DPM and Series 2.

43

SETUP OF CONNECTED METER
A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.
You will find that Instrument Setup software is very user friendly, with separate tabselectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.
ADDITIONAL FEATURES
• The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading 0’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

Plot

Graph
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• The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.
- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print for a hardcopy. List can capture peak readings.
- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.
- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.
• The Jumpers pull-down menu provides
jumper positions for the various meter boards,
duplicating information in this manual.
• The Calibration pull-down menu allows
easy calibration of voltage and current ranges
for the DC, load cell, and AC RMS signal
conditioner boards. The PC first recognizes
the type of board, then prompts you to apply
specific jumpers and calibration signals. Press
Ready to take a reading. Press Repeat to take
more readings. When you have decided on
which reading to accept, press on the number
1 through 10 of that reading. Additional calibration software is available online.
METER SETUP WITH AN UNCONNECTED PC
Instrument Setup software is also of benefit when the
PC is not connected to a meter. Upon launching the
software, click on None for Communications, then on
DPM and Series 2. Click on File => Default Setup to
retrieve a default setup file from disk, or on File => Open
Setup to retrieve a previously saved setup file from disk.
To enter new setup information, click on View => Setup,
then make your screen selections as if you were
connected to a meter. Tabs will be grayed out if you
have not selected the required hardware under the
Input+Display tab. When done, press on Main Menu,
then on View => Menu. The selections made under
Setup will now be shown in the form of the required front
panel programming sequence, where each row corresponds to a menu item selected by the
key, and the seven data columns correspond to values entered via the and keys.
Click on any step in the sequence to bring up a detailed help window.
Click on Print for a hardcopy, which you can then use as an instruction sheet to program
your meter via its front panel.
Click on Main Menu => File => Save Setup As to save your setup to disk and have an
electronic record.
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21. CUSTOM CURVE LINEARIZATION
Curve.exe is a DOS-based, executable PC program used to set up an Extended meter* so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on liquid level. The curvefitting algorithm uses quadratic segments of
varying length and curvature, and provides
diagnostics to estimate curve fitting errors.
The program is self-prompting, avoiding the
need for a detailed printed manual. This
manual section is only intended as an introduction and get-started guide.
PREREQUISITES
1) PC-compatible computer with an available Com 1 or Com 2 RS232 port.
2) Extended meter*.
3) An RS232 board in the meter. This board can be
used for meter setup only, then be removed.
4) An RJ11-to-DB9 RS232 cable to connect the
meter and PC (see Section 1, Ordering Guide).
5) Curve.exe software (downloadable from the web
at no charge).
GETTING STARTED
Download curve.exe into the same directory that will contain your data files, such as
key to get to SEr 1, then
c:\curves. Set the meter baud rate to 9600. To do so, press the
key to get to SEr
set the entry to __050. Set the meter address to 1. To do so, press the
2, then set the entry to _0011. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.
You will be given the choice to enter your data in one of four modes:
1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV,
V, mA or A. Y is the desired corresponding reading and can range from -99999 to
99999 with any decimal point.
2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.
3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1X^P1 + K2X^P2 +
K3*X^P3 + … are entered. Up to 20 terms are allowed. An offset can be built into X.
You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPM4L started to ship in August 2000.
You will be asked to supply the following:
LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >
This informs the computer of your signal conditioner jumper settings. Enter 0 and 0 for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 20V. Enter 200 for 200 mV or 200V. Enter 5 for 5A AC or DC. For HIGH
INPUT MEASUREMENT VALUE, enter 20000, except for 5A DC, where you should
enter 5000.
Position of the decimal point from 6=X.XXXXX, 5= XX.XXX, 4=XXX.XXX, 3=XXXX.XX,
2=XXXXX.X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the dEc.Pt decimal point menu selection.
Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.
KEYPAD CONTROL
You can take a meter in and out of custom curve linearization using the meter keypad. From
the Menu mode, press the
key to get to ConFG, then set the fifth digit to either 0
(normal linear operation) or to 1 (custom curve operation). This fifth digit will only be
displayed with an Extended meter*.
FILES USED OR CREATED BY CURVE.EXE
1) *.RAW is the raw input file generated by all four data entry methods.
2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.
3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.
4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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22. METER CALIBRATION
All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.
If recalibration is required, the meter may be returned to the factory or to any authorized
distributor. Easy calibration of DC, AC and load cell signal conditioner ranges is possible using
the Instrument Setup software, as described in Section 20. To allow computer aided calibration, an RS232 or RS485 interface card must be installed in the meter. This card may be
installed temporarily and be removed following calibration. Step-by-step instructions and
advanced calibration software are available from the factory.

23. SPECIFICATIONS
BASIC METER
Display
Type.................................... 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
Color ................................................................................................................... Red or green
Range .................................................................... -99999 to +99999 and -99990 to +99990
A to D Conversion
Technique (Pat.5,262,780) ........................................................................Concurrent SlopeTM
Read Rate ...............................................................60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update Rate..................................................................... 56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate..................................................................... 3.5/s at 60 Hz, 3/s at 50 Hz

Noise Rejection
CMV from DC to 60 Hz ............................................................................... Withstand 250Vac
Dielectric strength ....................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMR from DC to 60 Hz ................................................................................................. 130 dB
NMR at 50/60 Hz .............................................................. 90 dB with minimum digital filtering

Control Inputs (CMOS/TTL levels, logic 1 = tied to digital ground, logic 0 = open)
/ Hold input ......................................................................... Logic 1 holds display and outputs
/ Peak input...................................................................................Logic 1 displays peak value
/ Tare input ......................................................................... Logic 1 offsets input value to zero
/ Reset input ........................................................................ Logic 1 resets all meter functions
/ Function Reset input................................................. Logic 1 resets peak values and alarms
/ Decimal Point input..................... Overrides internal DP selections and controls DP position
ACCURACY
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DC Volts

RTD (0.01°, 0.1°, 1° resolution)

Voltage
Range

Resolution

Input
Ohms

Error at
25°C

200.00 mV
2.0000 V
20.000 V
200.00 V
300.0 V

10 µV
100 µV
1 mV
10 mV
100 mV

1 GO
1 GO
1 MO
1 MO
1 MO

0.01%
of FS
±2 Cts

Pt 100
Type

Range

Error at 25°C

DIN
-202 to 850°C .01% FS ±0.03°C
.00385 -331 to 1562°F .01% FS ±0.05°F
-202 to 631°C .01% FS ±0.04°C
ANSI
-331
to 1168°F .01% FS ±0.07°F
.003925
Thermocouple (0.1°, 1° resolution)

DC Amps
Current
Range

Resolution

Input
Ohms

Error at
25°C

TC
Type

2.0000 mA
20.000 mA
200.00 mA
5.000 A

0.1 µA
1 µA
10 µA
1 mA

100 O
10 O
1O
0.01 O

0.01%
of FS
±2 Cts

J

-210 to 760°C .01% FS ±0.09°C
-347to 1400°F .01% FS ±0.16°F

K

-244 to 1372°C .01% FS ±0.10°C
-408to 2501°F .01% FS ±0.17°F

Ratio
Current
Range

Resolution

200.00 mV 10 µV
2.0000 V
100 µV
20.000 V
1 mV

Input
Ohms
1 GO
1 GO
1 MO

T

Error at
25°C
0.01%
of FS
±2 Cts

Resolution

Input
Ohms

200.00 mV
2.0000 V
20.000 V
200.00 V
250.0 V

10 µV
100 µV
1 mV
10 mV
100 mV

22 MO
22 MO
1 MO
1 MO
1 MO

Error at
25°C
0.15%
of FS,
10 Hz to
10 kHz

0 to 400°C
-257 to 0°C
32 to 752°F
-430 to 32°F

N

-245 to 1300°C .01% FS ±0.10°C
-410 to 2370°F .01% FS ±0.17°F

S

-46 to +68°C .01% FS ±0.12°C
-51 to +213°F .01% FS ±0.22°F

R

-45 to 1768°C .01% FS ±0.17°C
-49 to 3214°F .01% FS ±0.31°F

Load Cell Input
Reso- Output Output Error at
Zero

Range

True RMS Amps (1% to 100% of Full Scale)
Resolution

Input
Ohms

Error at
25°C

2.0000 mA
20.000 mA
200.00 mA
5.000 A

0.1 µA
1 µA
10 µA
0.25 mA

100 O
10 O
1O
0.01 O

0.15%
of FS,
10 Hz to
10 kHz

.01% FS ±0.03°C
.01% FS ±0.20°C
.01% FS ±0.05°F
.01% FS ±0.36°F

-240 to 1000°C .01% FS ±0.18°C
-400 to 1830°F .01% FS ±0.32°F

Input

Current
Range

Error at 25°C

E

True RMS Volts (1% to 100% of Full Scale)
Voltage
Range

Range

Span

lution Range Range

25°C

20.000 mV 1 µV
50.000 mV 2.5 µV -99999
0.01%
0 to
100.00 mV 5 µV
to
of FS
250.00 mV 12.5 µV 99999 ±99,999 ±1 Ct
500.00 mV 25 µV
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Span Tempco ........................................................................................ 0.003% of reading/°C
0.0015% of reading/°C for load cell meter Zero Tempco
............................................................................................................0.2 µV/°C
Reference Junction Accuracy .................................................................... 1°C, 10°C to 40°C
POWER REQUIREMENTS
Input Voltage rating (standard) .................................. 95-240V ac ±10% or 90-300V dc ±10%
Input Voltage rating (low voltage option).............................................10-34V ac or 10-48V dc
Power Line Frequency..................................................................................DC and 47-63 Hz
Power Consumption, Max............................................................................................ 5 Watts

EXCITATION OUTPUTS
Voltage & Current Levels (jumper selectable) .................................. 5V dc ±5%, 100 mA max
10V dc ±5%, 120 mA max
24V dc ± 5%, 40 mA max
Excitation Output Ripple .................................................................................... 100 mVp max
Isolation from power and outputs................................................................................ 250 Vac
Insulation dielectric strength to power and outputs ..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation to signal common ........................................................................................... 50V dc

DUAL RELAY OPTION
Power to Relay Option................................................................................ Powered by meter
Setpoint Setup .......................................................Via front panel pushbuttons or RS232/485
Update Rate ................................................................................ 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (min) ................................................................. Display update rate
Input Signal (selectable) ....................................................... Filtered or unfiltered input signal
Actuation Modes (selectable) ...... Above or below setpoint, latching or non-latching,
disabled Output Time Delay (selectable) ....................................................................1 to 128
readings Front Panel Enable / Lockout Modes (selectable) ............... 1) Display and change
setpoints 2) Display but do not change setpoints 3) Neither display nor change setpoints
Alarm Status Indication..................................................................................2 red LED lamps
Status Indication Setup (selectable) ...................... Lit when output is ON or OFF, or disabled

Contact Relay Output:
AC Rating ......................................................................................................... 8A @ 240V ac
DC Rating ........................................................................................................... 8A @ 24V dc
Isolation rating between signal common and contacts................................................ 250V ac
Insulation dielectric strength between signal common and contacts........................................
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Solid State Relay Output:
AC Rating ......................................................120 mA @ 125V ac, 24 ohms series resistance
DC Rating ........................................................240 mA @ 150V dc, 6 ohms series resistance
Isolation rating between signal common and contacts................................................ 250V ac
Insulation dielectric strength between signal common and contacts........................................
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
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ANALOG OUTPUT OPTION
Power to Analog Output Option .................................................................. Powered by meter
Output Levels (voltage & current available simultaneously) ...0-20 mA or 4-20 mA and 0-10V
Voltage Compliance, 0-20 mA Output .................................................. 12V (0-600 Ohm load)
Current Compliance, 0-10V Output........................................... 2 mA (5 kOhm or higher load)
Accuracy............................................ Meter input accuracy ±0.1% of full scale analog output
Response Time......................................................................................... Display update rate
Scaling of Reading for Zero Output ........................................................... -99,999 to +99,999
Scaling of Reading for Full Scale Output .................................................. -99,999 to +99,999
Isolation rating between signal common and analog output ....................................... 250V ac
Insulation dielectric strength between signal common and analog output ...............................
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
SERIAL INTERFACE OPTION (RS232, RS485, RS485-Modbus boards)
Power to Interface Option ........................................................................... Powered by meter
RS485 Wiring ...............................................................................................Half or full duplex
Baud Rates.............................................................300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols.......................... Custom ASCII*, Modbus* RTU, Modbus* ASCII (selectable)
Signal Levels ....................................................................Meet RS232 and RS485 standards
Connectors ................ Single RJ11 (RS232), two RJ11 (RS485), two RJ45 (RS485-Modbus)
Isolation rating between signal common and serial I/O............................................... 250V ac
Insulation dielectric strength between signal common and serial I/O.......................................
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

PARALLEL BCD OUTPUT OPTION
Power to BCD Output Option...................................................................... Powered by meter
Type..................................................................................................... 3-state, stored, parallel
Signal Levels ..................................................................................LSTTL, CMOS compatible
Controls ................................................................................. BCD Enable, Hold, Data Ready
Isolation rating between signal common and BCD output .......................................... 250V ac
Insulation dielectric strength between signal common and BCD output ..................................
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

ENVIRONMENTAL
Operating Temperature ........................................................................................ 0°C to 55°C
Storage Temperature......................................................................................... -40°C to 85°C
Relative Humidity.......................................................95% from 0°C to 40°C, non-condensing
Case ...................................................................... NEMA-4X from front when panel mounted
Shock............................................................................10 G at 1 kHz, applied in X, Y, Z axes
Vibration ............................................. 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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24. GLOSSARY OF TERMS
Adaptive Filter Threshold
A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows a meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.
Alarm, Latched
An alarm which stays actuated until reset.
Latched alarms can shut down machinery or
a process when an operating limit has been
exceeded, or maintain an alarm condition
until acknowledged by an operator.
Alarm, Non-latched
An alarm which changes state automatically
when the reading rises above a specified limit
and changes back automatically when the
reading falls below a limit.
Autofilter

A selectable digital filter mode which automatically selects an appropriate moving average filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Auto-tare

A selectable meter operating mode, where
the first reading following power-on or meter reset is used to zero the display.
Further readings are then relative to this new zero.

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Counts

The reading displayed on the panel meter ignoring the decimal point.

Custom ASCII Protocol
A simplified, short protocol for use with these panel meters. It allows 31 digital
addresses. Not an industry-standard protocol, like the more complex Modbus
protocol, which is also offered with the meters.
Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and deactuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
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Setting up a passband around a setpoint is
often used for component testing. Deviation
limits are programmed by entering menu item
dEU1b for Alarm 1 and dEU2b for Alarm 2.
The deviation band will be equal to two limits.
Display Blank A rear panel input which blanks the display
when the input is tied to logic ground by a
switch or 0V is applied (logic level true). The
meter display will light when the input is open
or is held at +5V (logic level false).
Extended Meter
A digital panel meter with an enhanced microcomputer that provides added
capabilities, specifically linearization of nonlinear inputs and display of rate of
change from successive readings.
Full Scale The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is ±20 mV (signal
range from -20 mV to +20 mV).
Function Reset
A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or 0V is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic level
false) and then set low.
Ground Loop A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual
minimize ground loop problems by mutually isolating the grounds associated
with meter power, signal input, and all output and communication options.
Jumper A push-on component which provides a short between two adjacent posts on a circuit
board. Jumpers are used to configure signal conditioner boards for specific
signal types and full scale ranges, and to configure power supply and
communications boards for various modes of operation. Unused jumpers are
stored by pushing one side over an unused post.
Hysteresis Band
A band which controls relay action symmetrically around a setpoint. The relay
closes (or opens) when the reading goes
above the setpoint plus one hysteresis limit,
and opens (or closes) when the reading
falls below the setpoint less one hysteresis
limit. A narrow hysteresis band is often
used to minimize relay chatter around a
setpoint due to electrical noise or signal
feedback caused by load switching. A wide
hysteresis band can be used for control applications, such as turning on a fill
pump when the tank level has reached a lower limit and shutting off the pump
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when the tank level has reached an upper limit. The hysteresis band will be
equal to two hysteresis limits.
Menu Mode The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.
Meter Hold A rear panel input which freezes the meter display and all meter outputs while that
input is tied to logic ground by a switch or is held at 0V (logic level true). The
meter will resume operation when the input is allowed to float or is held at +5V
(logic level false).
Modbus An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same communication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.
Moving Average Filter
A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:
Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

Offset A constant adder used for the displayed reading. This is the term b in the straight line
formula y = mx + b, where y is the displayed reading in counts, m is the scale
factor, x is the measured reading in counts, and b is the offset. For direct
readout in (milli)volts or (milli)amps, offset is 0.
Peak Display The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.
Process Signal
A signal whose display requires setup of scale and offset settings for display in
engineering units. A classical process signal is 4-20 mA, where the 4 mA and
20 mA end points can each correspond to a desired meter reading.
Rate of Change Meter
A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.
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Reading The value displayed by the meter. “Taking a reading” is the action of the meter to
make an analog-to-digital conversion. Readings are taken at 60/sec with 60 Hz
power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.
Remote Display
A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.
Reset

There are three types of Reset:
§ Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.
§ Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.
§ Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved powering up the meter, by pressing the
RESET and MENU keys simultaneously, stepping through all top-level
menu choices, grounding a rear panel connector, or supplying an ASCII
command. rESEt is displayed briefly.

RS485 Half Duplex
Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.
RS485 Full Duplex
Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.
Run Mode

The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

Scale

A constant multiplier used to go from A/D
converter counts to displayed counts. This is
the slope term m in the straight line formula y
= mx + b, where y is the displayed reading in
counts, m is the scale factor, x is the
measured reading in counts, and b is the
offset. For direct readout in (milli)volts or
(milli)amps, scale is 1.

Scaling

The process of setting scale and offset so
that the meter reads properly in engineering
units (such as psi).

Scaling, Coordinates of 2 Points Method
A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
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then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item.
Scaling, Scale and Offset Mmethod
A scaling method where scale and offset are entered manually.
Scaling, Reading Coordinates of 2 Points Method
A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.
Setpoint

A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the
setpoint.

Span

The number of counts corresponding to a given signal range.

Tare

A rear panel input which causes the display to be set to zero when the input is
momentarily tied to logic ground by a switch or is held at 0V (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other applications where a reading relative to starting point is desired.

Valley Display
The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.
Zero When used with process meters, zero is an adjustment so that a given low transducer
output reads zero on the meter. Zero is adjusted by programming offset.
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25. WARRANTY

London Electronics Ltd. warrants its products against defects in materials or workmanship for a
period of one year from the date of purchase.
In the event of a defect during the warranty period, the unit should be returned, freight prepaid
(and all duties and taxes) by the Buyer, to the authorized London distributor where the unit was
purchased. The distributor, at its option, will repair or replace the defective unit. The unit will be
returned to the buyer with freight charges prepaid by the distributor.
LIMITATION OF WARRANTY
The foregoing warranty shall not apply to defects resulting from:
1.
2.
3.
4.

Improper or inadequate maintenance by Buyer.
Unauthorized modification or misuse.
Operation outside the environmental specifications of the product.
Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is
expressed or implied. London specifically disclaims the implied warranties of merchantability
and fitness for a particular purpose.
EXCLUSIVE REMEDIES
The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall
London be liable for direct, indirect, incidental or consequential damages (including loss of
profits) whether based on contract, tort, or any other legal theory.

REV-1A 12/06

- 57- -

